Crash Trifecta: A Complex Driving Scenario Describing Crash Causation

Naomi J. Dunn • Jeffery S. Hickman • Richard J. Hanowski

Submitted: June 13, 2014
ACKNOWLEDGMENTS

The authors of this report would like to acknowledge the support of the stakeholders of the National Surface Transportation Safety Center for Excellence (NSTSCE): Tom Dingus from the Virginia Tech Transportation Institute, John Capp from General Motors Corporation, Lincoln Cobb from the Federal Highway Administration, Chris Hayes from Travelers Insurance, Martin Walker from the Federal Motor Carrier Safety Administration, and Cathy McGhee from the Virginia Department of Transportation and the Virginia Center for Transportation Innovation and Research.

The NSTSCE stakeholders have jointly funded this research for the purpose of developing and disseminating advanced transportation safety techniques and innovations.
EXECUTIVE SUMMARY

When determining crash causation, crash databases emphasize a single, unitary critical reason (CR) as the primary proximal cause of a safety-critical event (SCE), which leaves no room for the specification of any other potential contributing factors to the crash/event genesis. This is despite the fact that it is well established in the transportation safety field that crash genesis typically involves a convergence of several factors. The aim of this study was to investigate the crash trifecta concept to determine if the convergence of multiple elements, rather than a single, unitary critical reason, has greater value in explaining the complexities of crash genesis. Specifically, the crash trifecta concept is defined as three separate, but converging, elements:

1. Unsafe pre-incident behavior or maneuver (e.g., speeding, tailgating, unsafe turn);
2. Transient driver inattention (which may be driving related, such as mirror use, or unrelated, such as reaching for an object); and
3. An unexpected traffic event (e.g., unexpected stopping by the vehicle ahead).

The value of the crash trifecta concept and convergence concepts in crash causation is that these concepts provide a structure for understanding the complexities of crash genesis. Thus, the crash trifecta concept may help explain the differences between the genesis of a crash and lower-severity SCEs (e.g., near-crashes).

METHODS

Seven existing naturalistic driving (ND) data sets, four of which were from truck-based ND studies and three from light-vehicle ND studies, were combined to ensure a sufficient number of SCEs for analyses. Data reduction had been previously completed on each of the seven ND data sets, which provided one of the variables of interest (i.e., driver behavior). The individual data sets were merged, and an indicator variable was created using the driver behavior variable to allow for easy detection of unsafe driving behavior (e.g., speeding, aggressive driving, improper turning). Eye-glance data had also been previously collected, reduced, and coded; thus, these data were used to assess transient driver inattention. The total time the driver’s eyes were off the forward roadway during the 5 seconds prior to an SCE was calculated. A threshold of more than 1 second was used for the determination of transient driver inattention. Thus, if the driver’s eyes were off the forward roadway for a total of more than 1 second prior to the triggering event, transient driver inattention was deemed to be present.

The remaining crash trifecta element (i.e., the presence of an unexpected event prior to, or during, an SCE) required new data reduction to be completed. Data analysts examined the 10 seconds of video data prior to an SCE to determine if an unexpected event occurred (with respect to the driver of the instrumented vehicle). An unexpected traffic event would indicate that something unforeseen occurred during the SCE. Examples of an unexpected traffic event included an animal, object, or debris on the road; another vehicle pulling out in front of the subject vehicle; the lead vehicle braking suddenly; another vehicle cutting in front of the subject vehicle; and changes in traffic occurring while the subject was not paying attention (e.g., traffic moving freely, subject driver looks away, and traffic stops).
RESULTS

Only those SCEs with data available for all three of the crash trifecta elements were included in the analysis. These were then classified in terms of the joint presence or absence of the three trifecta elements. Table 1 shows the breakdown of the total number of SCEs (n = 4,471), as well as those where the subject driver (i.e., the driver of the instrumented vehicle) was deemed to be at fault (n = 3,038). The SCEs were broken down by severity level and by the presence of each crash trifecta element (or combination of elements).

Table 1. Crash trifecta elements by event classification for total and at-fault SCEs.

<table>
<thead>
<tr>
<th>Crash Trifecta Elements</th>
<th>Crashes</th>
<th>Near-Crashes</th>
<th>Crash-Relevant Conflicts</th>
<th>Curb Strikes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Total (n=138)</td>
<td>At-Fault (n=94)</td>
<td>Total (n=1,202)</td>
<td>At-Fault (n=733)</td>
</tr>
<tr>
<td>None</td>
<td>4.4%</td>
<td>2.1%</td>
<td>2.2%</td>
<td>2.3%</td>
</tr>
<tr>
<td>Unexpected Traffic Event</td>
<td>6.5%</td>
<td>3.2%</td>
<td>9.1%</td>
<td>3.6%</td>
</tr>
<tr>
<td>Transient Inattention</td>
<td>9.4%</td>
<td>3.2%</td>
<td>1.7%</td>
<td>1.9%</td>
</tr>
<tr>
<td>Unsafe Driving Behavior</td>
<td>9.4%</td>
<td>10.6%</td>
<td>8.5%</td>
<td>11.6%</td>
</tr>
<tr>
<td>Unexpected Event + Transient Inattention</td>
<td>3.6%</td>
<td>1.1%</td>
<td>3.1%</td>
<td>1.5%</td>
</tr>
<tr>
<td>Unexpected Event + Unsafe Behavior</td>
<td>18.1%</td>
<td>16.0%</td>
<td>41.9%</td>
<td>37.2%</td>
</tr>
<tr>
<td>Unsafe Behavior + Transient Inattention</td>
<td>23.9%</td>
<td>31.9%</td>
<td>9.4%</td>
<td>13.9%</td>
</tr>
<tr>
<td>Crash Trifecta</td>
<td>24.7%</td>
<td>31.9%</td>
<td>24.1%</td>
<td>28.0%</td>
</tr>
<tr>
<td>Total</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
</tr>
</tbody>
</table>

In regard to individual crash trifecta elements, unsafe driving behavior was the most prevalent crash trifecta element, both individually and in combination with the other elements (coded in ~82 percent to ~94 percent of the total and at-fault SCEs, respectively). The majority of curb strikes were attributable to a combination of unsafe driving behavior and transient driver inattention (coded in ~62 percent of the total SCEs and ~59 percent of at-fault SCEs), as were the majority of crash-relevant conflicts (~34 percent total and ~44 percent at-fault). The majority of near-crashes were the result of an unexpected event combined with unsafe driving behavior.
(42 percent of the total SCEs and 37 percent of the at-fault SCEs). Approximately 80 percent of the at-fault crashes had at least two crash trifecta elements present, with almost one-third having all three crash trifecta elements present. The percentage of SCEs having all three crash trifecta elements increased as the severity of the SCE increased. This was evident in the total SCEs (10.6 percent in crash-relevant conflicts, 24.1 percent in near-crashes, and 24.6 percent in crashes), as well as the at-fault SCEs (10.8 percent in crash-relevant conflicts, 28.0 percent in near-crashes, and 31.9 percent in crashes). Curb strikes were excluded due to the variance in severity.

CONCLUSIONS

The results of this study clearly show that multiple converging elements need to be considered when investigating crash causation. When examining the presence of each element with the varying severity of the SCEs, the pattern of results makes intuitive sense. For example, inattention was present in approximately two-thirds of crashes, but only ~40 percent of the near-crashes. The presence of transient inattention means that a driver cannot react as quickly and, therefore, is less likely to make a successful avoidance response, which subsequently results in a crash rather than a near-crash. An unexpected event was present in approximately three-quarters of the near-crashes but in just over half the crashes. The absence of transient driver inattention in the majority of the near-crashes (~60 percent) meant the driver was able to successfully respond to the unexpected event and avoid a crash. Thus, it appears to be the convergence of transient inattention and unexpected events that plays an important role in the increasing severity level from near-crash to crash. There were few crashes and curb strikes compared to near-crashes and crash-relevant conflicts; thus, it is premature to identify trends in the presence of specific crash trifecta elements or to rank the importance of the three elements.

Although less than one-third of all the SCEs had only one crash trifecta element present (i.e., equivalent to a single CR for an event), approximately two-thirds of all the SCEs had at least two crash trifecta elements present. Most notably, the presence of all three crash trifecta elements increased as the severity of the SCE increased. Almost one-quarter of crashes and near-crashes included all three crash trifecta elements compared to 10 percent of crash-relevant conflicts. Similarly, when focusing on at-fault SCEs, approximately one-third of crashes and over one-quarter of near-crashes were attributable to a combination of all three crash trifecta elements compared to 10 percent of crash-relevant conflicts.

These results suggest that assigning a single, unitary CR as the proximal cause of the SCE without considering additional contributing factors is likely to be a limitation that does not address the complexities involved in the genesis of a crash. Assigning a CR may be suitable for lower-severity SCEs, but when investigating higher-severity SCEs, the convergence of multiple elements needs to be recognized to adequately represent the complexities involved in the origins and formation of a crash event. Moreover, the crash trifecta concept may be able to assist researchers in determining why a crash occurred compared with a similar situation that resulted in a successful avoidance maneuver, such as a near-crash. The crash trifecta concept may also be helpful in identifying countermeasures for crash mitigation, particularly since the two most prevalent crash trifecta elements are largely under the driver’s control (i.e., unsafe driving behavior and transient driver inattention).
# TABLE OF CONTENTS

LIST OF FIGURES ............................................................................................................................ vii

LIST OF TABLES .............................................................................................................................. ix

LIST OF ABBREVIATIONS AND SYMBOLS .................................................................................. xi

CHAPTER 1. INTRODUCTION .......................................................................................................... 1
  OVERVIEW OF THE CURRENT STUDY ...................................................................................... 4

CHAPTER 2. METHODS ..................................................................................................................... 5
  OVERVIEW OF THE DATA SETS USED IN THE CURRENT STUDY ........................................... 5
    The 100-Car Naturalistic Driving Study (NDS) .......................................................................... 5
    Senior Driver NDS ...................................................................................................................... 5
    The Drowsy Driver Warning System Field Operational Test (DDWS FOT) .............................. 5
    The Naturalistic Truck Driving Study (NTDS) .......................................................................... 5
    The Field Demonstration of Heavy Vehicle Camera/Video Imaging Systems (C/VIS) .......... 5
    Federal Motor Carrier Safety Administration’s Advanced System utilizing a Data Acquisition System on the Highways (FAST DASH) ........................................................................... 6
    The Strategic Highway Research Program 2 (SHRP 2) NDS .................................................. 6
  DATA SET FORMATTING .............................................................................................................. 6
  DATA REDUCTION ........................................................................................................................ 7
    Quality Control and Reliability .................................................................................................. 7

CHAPTER 3. RESULTS ....................................................................................................................... 9

CHAPTER 4. CONCLUSIONS ........................................................................................................... 13
  LIMITATIONS ............................................................................................................................... 14

APPENDIX A: UNSAFE DRIVING BEHAVIORS ........................................................................... 15

APPENDIX B: UNEXPECTED EVENT DATA REDUCTION PROTOCOL ........................................ 19

REFERENCES .................................................................................................................................... 23
LIST OF FIGURES

Figure 1. Diagram. Unsafe pre-incident behavior (e.g., tailgating)................................. 2
Figure 2. Photo. Transient driver inattention (e.g., sending a text message). ....................... 3
Figure 3. Diagram. Unexpected traffic event (e.g., deer on the road causes lead vehicle to brake suddenly)......................................................................................................................... 3
Figure 4. Diagram. Outcome: Truck at-fault crash. ............................................................... 4
LIST OF TABLES

Table 1. Crash trifecta event classification................................................................. 9
Table 2. Crash trifecta elements by event classification................................................ 10
Table 3. At-fault crash trifecta elements by event classification. .................................. 11
### LIST OF ABBREVIATIONS AND SYMBOLS

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMV</td>
<td>Commercial Motor Vehicle</td>
</tr>
<tr>
<td>CR</td>
<td>critical reason</td>
</tr>
<tr>
<td>C/VIS</td>
<td>Camera/Video Imaging System</td>
</tr>
<tr>
<td>DAS</td>
<td>data acquisition system</td>
</tr>
<tr>
<td>DDWS FOT</td>
<td>Drowsy Driver Warning System Field Operational Test</td>
</tr>
<tr>
<td>FAST DASH</td>
<td>Federal Motor Carrier Safety Administration’s Advanced System utilizing a Data Acquisition System on the Highways</td>
</tr>
<tr>
<td>ND</td>
<td>naturalistic driving</td>
</tr>
<tr>
<td>NDS</td>
<td>Naturalistic Driving Study</td>
</tr>
<tr>
<td>NTDS</td>
<td>Naturalistic Truck Driving Study</td>
</tr>
<tr>
<td>SCE</td>
<td>safety-critical event</td>
</tr>
<tr>
<td>U.S. DOT</td>
<td>United States Department of Transportation</td>
</tr>
<tr>
<td>VTTI</td>
<td>Virginia Tech Transportation Institute</td>
</tr>
</tbody>
</table>
CRASH DATABASES COMPILED FROM POLICE ACCIDENT REPORTS AND NATURALISTIC DRIVING (ND) STUDIES EMPHASIZE THE CRITICAL REASON (CR) AS A PRIMARY PROXIMAL CAUSE IN A SAFETY-CRITICAL EVENT (SCE) AND DO NOT ALLOW ROOM FOR THE SPECIFICATION OF ANY FACTOR OTHER THAN THE CR AS DIRECTLY CONTRIBUTING TO CRASH/EVENT GENESIS. HOWEVER, IN REALITY, THERE IS OFTEN MORE THAN ONE FACTOR THAT CONTRIBUTES TO THE FORMATION OF AN SCE, WHICH MAY INCLUDE ONGOING PRE-EVENT BEHAVIORS OR TRANSIENT, PRECIPITATING ERRORS. AN SCE IS AN EVENT THAT MAY BE CLASSIFIED AS EITHER A CRASH, NEAR-CRASH, OR CRASH-RELEVANT CONFLICT. THE CRASH TRIFECTA CONCEPT DOES NOT CONSIDER CRASH GENESIS AS A SIMPLE UNITARY ELEMENT, BUT RATHER A CONVERGENCE OF ELEMENTS. SPECIFICALLY, THE CRASH TRIFECTA CONCEPT IS DEFINED AS THREE SEPARATE, BUT CONVERGING, ELEMENTS:

1. Unsafe pre-incident behavior or maneuver (e.g., speeding, tailgating, unsafe turn);
2. Transient driver inattention (which may be driving related, such as mirror use, or unrelated, such as reaching for an object); and
3. An unexpected traffic event (e.g., unexpected stopping by the vehicle ahead).

A number of other models exist in the injury prevention field that can be adapted and applied to investigate crash causation. The most widely known of these is James Reason’s “Swiss cheese” model, which moved away from earlier models of human error by accepting that accidents were not solely due to individual operator error (i.e., active errors) but instead involved wider systemic organizational factors (i.e., latent conditions). Active errors were those “where the effect is felt almost immediately.” Latent conditions “tended to lie dormant in the system largely undetected until they combined with other factors to breach system defenses” (p. 173). Reason’s model visualizes multiple layers of defenses, barriers, and safeguards to prevent error. However, these layers, like slices of Swiss cheese, contain holes. Some of these holes are due to active errors and some are due to latent conditions, but when the holes become aligned, an incident occurs. When using this model to investigate crash causation, Knipling proposed changing the layers from “defenses” to aspects of driver behavior, performance, and the road environment. Thus, the holes in the layers represent driver errors or driving threats, such as driving too fast, tailgating, distraction, slippery patches on the road, and cars cutting in to traffic. When using this model to investigate crash causation, the main drawback is that the holes in the multiple layers need to align for a crash to occur. That is, if there are three layers in the model, then the model can only account for crashes that are the result of errors or conditions occurring in each layer. It cannot account for crashes that are the result of a single error, such as speeding or slippery patches on the road. The crash trifecta concept, on the other hand, classifies SCEs in terms of the presence or absence of each of the three elements. Thus, it accounts for SCEs that are due to a single element or a convergence of elements.

Another crash causation model was developed by William Haddon. The Haddon Matrix was initially developed as an injury prevention tool but has also been adapted for use in transportation safety. The matrix identifies risk factors before the crash, during the crash, and after the crash, relative to the person, vehicle, and environment. Each phase (i.e., pre-crash, crash, and post-crash) can be analyzed systematically for human, vehicle, road, and environmental factors, thus allowing for the identification of interventions and prevention...
strategies by phases in time of the incident. In the pre-crash phase, interventions or countermeasures are aimed at preventing the crash from occurring (e.g., vehicle warning systems, such as lane departure warning systems). The crash phase involves interventions or countermeasures to prevent injury from occurring or to reduce the severity of an injury that did occur (e.g., vehicle safety devices, such as airbags or seat belts). Interventions or activities that occur during the post-crash phase are aimed at reducing the adverse outcomes of the crash (e.g., appropriate medical care and/or rehabilitation).

The Haddon Matrix is essentially a brainstorming tool designed to generate ideas about interventions, whereas the crash trifecta concept provides a structure for understanding the complexities involved in the genesis of a crash.

The crash trifecta is not a new concept. It has been well established in the transportation safety field that crash genesis involves a convergence of several factors. For example, driving while distracted diverts attention away from the task of driving toward a competing activity. If the driver is not paying attention to the road, he/she is much less likely to notice an unexpected event, such as a sudden stop in traffic ahead, thereby increasing the likelihood of being involved in a crash. Thus, the crash trifecta concept implies that the probability of a crash is greater if the three crash trifecta elements are present than if only one of the crash trifecta elements is present. Indeed, a pilot study of the crash trifecta concept by Bocanegra et al. showed there was an increasing trend in the presence of all three crash trifecta elements as the severity of the SCE increased. Bocanegra et al. analyzed 272 SCEs from two naturalistic truck data sets and found the presence of all three trifecta elements increased with the severity of the SCE (9.4 percent in crash-relevant conflicts, 20.0 percent in near-crashes, and 25.0 percent in crashes). These pilot results suggest that higher-severity SCEs are more likely to involve the convergence of multiple elements and that lower-severity SCEs may be attributed to a unitary element. Although Bocanegra et al. found that only 2.6 percent of SCEs had none of the crash trifecta elements present, nearly half the SCEs had at least two of the crash trifecta elements present.

Figures 1 to 4, adapted from Knipling, illustrate the crash trifecta concept as a model for an at-fault crash, although it must be noted that the model can apply to other types of crashes and all three elements do not need to be present for a crash to occur. Figure 1 depicts the first element in the crash trifecta, which is the unsafe pre-incident behavior. This is essentially a voluntary behavior (i.e., the behavior is usually under the driver’s control) and may be ongoing prior to the SCE. For example, going too fast in relation to other vehicles and/or tailgating are both behaviors that are ongoing and under the driver’s control.

![Figure 1. Diagram. Unsafe pre-incident behavior (e.g., tailgating).](image)

Figure 2 depicts the second element of the crash trifecta, which is transient driver inattention. Transient inattention can happen to any driver. However, the rate and length of these periods of
inattention can be diminished by reducing behaviors that are associated with inattention. For example, sending a text message on a cell phone while driving results in the driver taking his/her eyes off the forward roadway for an extended period of time, thereby increasing the risk of being involved in an SCE.\(^\text{(7)}\)

![Image of driving with a mobile phone]

**Figure 2. Photo. Transient driver inattention (e.g., sending a text message).**

Figure 3 depicts the third element of the crash trifecta, which is an unexpected traffic event. This refers to a completely random event or unexpected action made by another vehicle. These are events over which the driver has no control, such as a deer running out in front of the vehicle, although such events are more likely to be anticipated in time if the driver is paying attention.\(^\text{(4)}\)

![Image of a truck, car, and deer]

**Figure 3. Diagram. Unexpected traffic event (e.g., deer on the road causes lead vehicle to brake suddenly).**

As can be seen in Figure 4, the individual elements added together create a scenario that results in an at-fault crash for the truck driver. It is possible for any one of the crash trifecta elements to be missing for the crash to be avoided. For instance, if the truck driver’s eyes were on the forward roadway, he/she may have noticed the deer on the road. Despite the fact that the truck driver was tailgating, he/she may have been able to stop in time or engage in an evasive maneuver that would have prevented contact with the lead vehicle. Similarly, if the truck driver had not been tailgating the lead vehicle when the deer appeared on the road, he/she would have had more time to focus attention back on the forward roadway and engage in an evasive maneuver to avoid a collision. However, the combination of all three crash trifecta elements creates a scenario whereby a crash is almost unavoidable.
Figure 4. Diagram. Outcome: Truck at-fault crash.

Although the crash trifecta concept seems intuitive, until recently it has been difficult to measure. The data acquisition system (DAS) used in ND studies collects continuous video and parametric data pertaining to the vehicle, its location, and its distance to surrounding objects during an extended period of time. This presents researchers with the unique opportunity to directly observe driver behavior and vehicle status prior to SCEs to determine convergences of multiple elements, such as the common pattern outlined above in the crash trifecta. The value of the crash trifecta concept and convergence concepts in crash causation is that these concepts provide a structure for understanding the complexities of crash genesis. Thus, the crash trifecta concept may help explain the differences between the genesis of a crash and lower-severity SCEs. Additionally, a better understanding of converging elements that lead to a crash may result in countermeasures aimed at preventing or reducing the severity of crashes.

OVERVIEW OF THE CURRENT STUDY

The current study builds on the methods used in Bocanegra et al.\(^{(1)}\) and addresses a number of issues in the design of the initial pilot study. Granted, the Bocanegra et al. study was a pilot; thus, it was limited in sample size. However, it also only used truck-specific data. The current study used a mix of truck and light-vehicle ND data sets comprising over 4,400 SCEs, resulting in a larger, more diverse data set. The Bocanegra et al. study investigated the presence of the crash trifecta elements in a sample of crashes, near-crashes, crash-relevant conflicts, and unintentional lane deviations. This differs slightly from the current study, which did not include unintentional lane deviations as those particular SCEs were only available in the truck ND data sets. Bocanegra et al. also did not separate out curb strikes from crashes. Curb strikes were technically defined as crashes due to the transfer of kinetic energy that occurs when a vehicle hits a curb. However, there was a great deal of variance in the severity of these SCEs, which sets them apart from the traditional “crash” and warrants the need for a separate grouping. Some curb strikes were less severe than a crash-relevant conflict, such as hitting the curb at a very low speed while parking a vehicle; others were similar to a near-crash, such as hitting the median at a high speed on a freeway. The current study created a separate group for curb strikes to mitigate this problem.

The current study provides an opportunity for a more complete understanding of crash genesis and potential countermeasures. Other existing crash causation models do not provide the same structure for understanding crashes and/or SCEs of varying complexities. Thus, the crash trifecta concept has greater explanatory value than previous models.
CHAPTER 2. METHODS

OVERVIEW OF THE DATA SETS USED IN THE CURRENT STUDY

The current study was a secondary analysis using seven existing ND data sets, four of which were from truck-based ND studies and three from light-vehicle ND studies. Below is a brief description of each ND study.

The 100-Car Naturalistic Driving Study (NDS)

The 100-Car NDS was the first instrumented-vehicle study undertaken with the primary goal of collecting large-scale ND data. The data set comprised approximately 43,000 hours of driving data from 241 primary and secondary drivers collected over a 12- to 13-month period for each vehicle. See Dingus et al.\(^8\) for a complete description of the 100-Car NDS.

Senior Driver NDS

The Senior Driver NDS was a comparatively small study designed to investigate the relative risk of high-demand driving situations for older drivers. Data were collected for 12 months per participant from a total of 20 primary drivers between 70 and 85 years of age. The resulting data set contained approximately 4,600 hours of driving data. See the Virginia Tech Transportation Institute (VTTI) website http://www.vtti.vt.edu/research/vrus/projects/olderdriver/olderdriver.html for further details of the study.

The Drowsy Driver Warning System Field Operational Test (DDWS FOT)

The DDWS FOT was the largest ND commercial motor vehicle (CMV) study ever conducted by the U.S. Department of Transportation (U.S. DOT) with more than 12 terabytes of kinematic and video data. Data were collected for 18 months from 103 drivers of 46 instrumented trucks. The resulting database contained approximately 2.3 million miles traveled. See Blanco et al.\(^2\) for a complete description of the DDWS FOT.

The Naturalistic Truck Driving Study (NTDS)

The NTDS was another ND truck study that collected more than 4 terabytes of kinematic and video data. The NTDS collected continuous driving data from 100 drivers of nine instrumented trucks, with each driver being observed for approximately 4 consecutive workweeks. The resulting database contained approximately 735,000 miles of driving data. See Blanco et al.\(^9\) for a complete description of the NTDS.

The Field Demonstration of Heavy Vehicle Camera/Video Imaging Systems (C/VIS)

The C/VIS study was conducted to evaluate the benefits and disbenefits of the implementation of C/VISs in real-world trucking operations. A total of 3.62 terabytes of data were collected over a 12-month period from 12 CMV drivers of six instrumented trucks, with each driver being observed for 4 months. The resulting database contained approximately 278,000 miles of driving data. See Fitch et al.\(^10\) for a complete description of the C/VIS study.
Federal Motor Carrier Safety Administration’s Advanced System utilizing a Data Acquisition System on the Highways (FAST DASH)

The purpose of the ongoing FAST DASH study is to evaluate safety technologies aimed at improving CMV operations. Data from Phase I were collected over an 11-month period from 21 drivers of 20 instrumented trucks, with each driver being observed for 6 months. The resulting database contained approximately 722,000 miles of driving data. See Schaudt et al.\textsuperscript{(11)} for a complete description of FAST DASH.

The Strategic Highway Research Program 2 (SHRP 2) NDS

The SHRP 2 NDS is currently underway and is the largest study of its kind ever conducted. The study incorporates approximately 3,100 drivers in six states throughout the United States, with each driver driving an instrumented vehicle for 12 to 24 months. The drivers include men and women of various age groups, from different geographic areas, driving different types of light vehicles. See the SHRP 2 website www.trb.org/StrategicHighwayResearchProgram2SHRP2/Blank2.aspx for a complete description of the study.

DATA SET FORMATTING

The crash trifecta model was applied to SCEs found in the seven existing ND data sets. Prior to any analyses, the data were formatted and merged into one data set, which comprised SCEs defined as follows:\textsuperscript{(10)}

- **Crash:** Any contact with an object, either moving or fixed, at any speed in which kinetic energy is measurably transferred or dissipated. Includes other vehicles, roadside barriers, objects on or off the roadway, pedestrians, cyclists, or animals.

- **Curb Strike:** Any contact with a curb or median.

- **Near-Crash:** Any circumstance requiring a rapid, evasive maneuver by the subject vehicle, or any other vehicle, pedestrian, cyclist, or animal, to avoid a crash, or any circumstance that results in extraordinarily close proximity of the subject vehicle to any other vehicle, pedestrian, cyclist, animal, or fixed object where, due to apparent unawareness on the part of the driver(s), pedestrian(s), cyclist(s), or animal(s), there is no avoidance maneuver or response. A rapid evasive maneuver is defined as steering, braking, accelerating, or any other combination of control inputs that approaches the limits of the vehicle’s capabilities.

- **Crash-Relevant Conflict:** Any circumstance that requires a crash-avoidance response on the part of the subject vehicle, or any other vehicle, pedestrian, cyclist, or animal, that is less severe than a rapid evasive maneuver (as defined above) but greater in severity than a “normal maneuver” to avoid a crash, or any circumstance that results in close proximity of the subject vehicle to any other vehicle, pedestrian, cyclist, animal, or fixed object where, due to apparent unawareness on the part of the driver(s), pedestrian(s), cyclist(s), or animal(s), there is no avoidance maneuver or response. A crash-avoidance response can include braking, steering, accelerating, or any combination of control inputs.
DATA REDUCTION

Data reduction had been previously completed on each of the seven ND data sets, which provided one of the variables of interest (i.e., driver behavior). The individual data sets were merged, and an indicator variable was created using the driver behavior variable to allow for easy detection of unsafe driving behavior. Examples of unsafe driving behavior included speeding; aggressive driving; improper turning; stop sign or signal violation; drowsy, inattentive, or distracted driving; excessive or sudden braking/stopping; following too close; and illegal passing. See Appendix A for a complete list of unsafe driving behaviors. Eye-glance data had also been previously collected, reduced, and coded; these data were used to assess transient driver inattention. The total time the driver’s eyes were off the forward roadway during the 5 seconds prior to an SCE was calculated. Similar to Bocanegra et al.,(1) the current study used a threshold of more than 1 second for the determination of transient driver inattention. Using a threshold of more than 1 second for the determination of transient driver inattention was consistent with the threshold for a significant increase in the odds of involvement in an SCE, as documented in Olson et al.(7) Thus, if the driver’s eyes were off the forward roadway for a total of more than 1 second prior to the triggering event, transient driver inattention was deemed to be present.

The remaining crash trifecta element (i.e., the presence of an unexpected event prior to, or during, an SCE) required new data reduction to be completed. Data analysts examined the 10 seconds of video data prior to an SCE to determine if an unexpected event occurred (with respect to the driver of the instrumented vehicle). An unexpected traffic event would indicate that something unforeseen occurred during the SCE. Examples of unexpected traffic events included an animal, object, or debris on the road; another vehicle pulling out in front of the subject vehicle; the lead vehicle braking suddenly; another vehicle cutting in front of the subject vehicle; and changes in traffic occurring while the subject was not paying attention (e.g., traffic moving freely, subject driver looks away, and traffic stops). See Appendix B for the operational definition of an unexpected traffic event and the data reduction protocol.

Quality Control and Reliability

The data reduction process for the unexpected event variable involved subjective interpretation of video data; thus, reliability estimates of data analysts’ subjective judgments were crucial to the data reduction process. These inter-rater reliability estimates verified that different data analysts followed the data reduction protocols in the same way. Approximately 50 percent of the SCEs that made up the initial data set of just over 5,000 events were reviewed by a second data analyst to ensure inter-rater reliability. Of the 2,431 SCEs that underwent reliability checks, whole agreement between the analysts was achieved for 2,257 SCEs (i.e., 92.8 percent agreement). In the 167 instances where the analysts did not initially agree in their judgment, they discussed their reasoning and reviewed the video together before arriving at a mutually agreeable decision. The remaining 7 cases where the analysts could not mutually agree on a decision were passed on to the project manager, who made the final decision.
CHAPTER 3. RESULTS

Only those SCEs with data available for all three of the crash trifecta elements were included in the analysis. These were then classified in terms of the joint presence or absence of the three trifecta elements. Table 1 shows the severity level of the 4,471 SCEs included in the crash trifecta analysis.

Table 1. Crash trifecta event classification.

<table>
<thead>
<tr>
<th>Severity Level</th>
<th>Number of Crash Trifecta Events (n = 4,471)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crash</td>
<td>138</td>
</tr>
<tr>
<td>Near-Crash</td>
<td>1,202</td>
</tr>
<tr>
<td>Crash-Relevant Conflict</td>
<td>3,060</td>
</tr>
<tr>
<td>Curb Strike</td>
<td>71</td>
</tr>
</tbody>
</table>

Table 2 shows the presence of each crash trifecta element (and combination) by SCE severity. Although only 3 percent of the SCEs had none of the crash trifecta elements present, two-thirds of the SCEs had at least two of the crash trifecta elements present. An example of an SCE displaying none of the crash trifecta elements would be the subject vehicle stopping at a red traffic signal and being rear-ended by the vehicle behind. Approximately one-third of the crash-relevant conflicts were attributable to a combination of unsafe pre-incident driving behavior and transient driver inattention, and another one-third had only one of the crash trifecta elements present. More than 40 percent of near-crashes were the result of an unexpected traffic event and unsafe pre-incident driving behavior, and one-quarter of near-crashes included all three crash trifecta elements. Curb strikes were largely attributable to unsafe pre-incident driving behavior and transient driver inattention (62 percent). The majority of crashes (approximately 70 percent) had at least two crash trifecta elements present, and one-quarter included all three crash trifecta elements. The percentage of SCEs having all three crash trifecta elements increased as the severity of the SCE increased (10.6 percent in crash-relevant conflicts, 24.1 percent in near-crashes, and 24.6 percent in crashes [curb strikes were excluded due to the variance in severity]).
Table 2. Crash trifecta elements by event classification.

<table>
<thead>
<tr>
<th>Crash Trifecta Elements</th>
<th>Crash ( (n = 138) )</th>
<th>Near-Crash ( (n = 1,202) )</th>
<th>Crash-Relevant Conflicts ( (n = 3,060) )</th>
<th>Curb Strikes ( (n = 71) )</th>
<th>Total ( (n = 4,471) )</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>4.35%</td>
<td>2.16%</td>
<td>3.27%</td>
<td>4.23%</td>
<td>3.02%</td>
</tr>
<tr>
<td>Unexpected Traffic Event</td>
<td>6.52%</td>
<td>9.07%</td>
<td>11.80%</td>
<td>0.00%</td>
<td>10.72%</td>
</tr>
<tr>
<td>Transient Inattention</td>
<td>9.42%</td>
<td>1.75%</td>
<td>2.19%</td>
<td>2.82%</td>
<td>2.30%</td>
</tr>
<tr>
<td>Unsafe Driving Behavior</td>
<td>9.42%</td>
<td>8.48%</td>
<td>19.97%</td>
<td>26.76%</td>
<td>16.66%</td>
</tr>
<tr>
<td>Unexpected Event + Transient Inattention</td>
<td>3.62%</td>
<td>3.08%</td>
<td>3.50%</td>
<td>0.00%</td>
<td>3.33%</td>
</tr>
<tr>
<td>Unexpected Event + Unsafe Behavior</td>
<td>18.12%</td>
<td>41.93%</td>
<td>15.19%</td>
<td>0.00%</td>
<td>22.23%</td>
</tr>
<tr>
<td>Unsafe Behavior + Transient Inattention</td>
<td>23.91%</td>
<td>9.40%</td>
<td>33.49%</td>
<td>61.96%</td>
<td>27.18%</td>
</tr>
<tr>
<td>Crash Trifecta</td>
<td>24.64%</td>
<td>24.13%</td>
<td>10.59%</td>
<td>4.23%</td>
<td>14.56%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>100.00%</strong></td>
<td><strong>100.00%</strong></td>
<td><strong>100.00%</strong></td>
<td><strong>100.00%</strong></td>
<td><strong>100.00%</strong></td>
</tr>
</tbody>
</table>

Table 3 shows the presence of the crash trifecta elements by SCE severity for SCEs where the subject driver (i.e., the driver of the instrumented vehicle) was deemed to be at fault. In regard to individual crash trifecta elements, unsafe driving behavior was coded in approximately 20 percent of the at-fault SCEs compared to less than 2 percent each for unexpected traffic events and transient driver inattention. The majority of at-fault curb strikes and crash-relevant conflicts were attributable to a combination of unsafe driving behavior and transient driver inattention (59 percent and 44 percent, respectively). Approximately 37 percent of at-fault near-crashes were the result of an unexpected traffic event combined with unsafe driving behavior, and 28 percent included all three crash trifecta elements. Approximately 80 percent of the at-fault crashes had at least two crash trifecta elements present, with almost one-third having all three crash trifecta elements present. The percentage of at-fault SCEs that included all three crash trifecta elements increased as the severity of the SCE increased (10.8 percent in crash-relevant conflicts, 28.0 percent in near-crashes, and 31.9 percent in crashes). As before, curb strikes were excluded due to the variance in severity.
<table>
<thead>
<tr>
<th>Crash Trifecta Elements</th>
<th>Crash ( (n = 94) )</th>
<th>Near-Crash ( (n = 733) )</th>
<th>Crash-Relevant Conflicts ( (n = 2,150) )</th>
<th>Curb Strikes ( (n = 61) )</th>
<th>Total ( (n = 3,038) )</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>2.13%</td>
<td>2.32%</td>
<td>1.07%</td>
<td>4.92%</td>
<td>1.48%</td>
</tr>
<tr>
<td>Unexpected Traffic Event</td>
<td>3.19%</td>
<td>3.55%</td>
<td>1.26%</td>
<td>0.00%</td>
<td>1.84%</td>
</tr>
<tr>
<td>Transient Inattention</td>
<td>3.19%</td>
<td>1.91%</td>
<td>1.26%</td>
<td>3.28%</td>
<td>1.51%</td>
</tr>
<tr>
<td>Unsafe Driving Behavior</td>
<td>10.64%</td>
<td>11.59%</td>
<td>25.21%</td>
<td>29.51%</td>
<td>21.56%</td>
</tr>
<tr>
<td>Unexpected Event + Transient Inattention</td>
<td>1.06%</td>
<td>1.50%</td>
<td>0.70%</td>
<td>0.00%</td>
<td>0.89%</td>
</tr>
<tr>
<td>Unexpected Event + Unsafe Behavior</td>
<td>15.97%</td>
<td>37.24%</td>
<td>15.25%</td>
<td>0.00%</td>
<td>20.28%</td>
</tr>
<tr>
<td>Unsafe Behavior + Transient Inattention</td>
<td>31.91%</td>
<td>13.92%</td>
<td>44.46%</td>
<td>59.02%</td>
<td>37.00%</td>
</tr>
<tr>
<td>Crash Trifecta</td>
<td>31.91%</td>
<td>27.97%</td>
<td>10.79%</td>
<td>3.27%</td>
<td>15.44%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>100.00%</strong></td>
<td><strong>100.00%</strong></td>
<td><strong>100.00%</strong></td>
<td><strong>100.00%</strong></td>
<td><strong>100.00%</strong></td>
</tr>
</tbody>
</table>
CHAPTER 4. CONCLUSIONS

The results of this study clearly show that multiple converging elements need to be considered when investigating crash causation. It appears that driver behavior (unsafe behavior) was the most prevalent crash trifecta element (coded in ~82 percent to ~94 percent of the total and at-fault SCEs, respectively). This is consistent with most crash causation studies (e.g., National Highway Traffic Safety Administration\(^{12}\), Dingus et al.\(^{8}\), Knipling\(^{4}\)). The second most prevalent crash trifecta element was transient driver inattention (coded in ~47 percent to ~55 percent of the total and at-fault SCEs, respectively) followed by an unexpected traffic event (coded in ~51 percent of the total SCEs and ~38 percent of the at-fault SCEs). When examining the presence of each element with the varying severity of the SCEs, the pattern of results makes intuitive sense. For example, inattention was present in approximately 61 percent to 68 percent of crashes (total and at-fault, respectively) but in only 38 percent to 45 percent of near-crashes (total and at-fault, respectively). A possible explanation for this is that the presence of transient inattention means the driver cannot react as quickly and, therefore, is less likely to make a successful avoidance response, which subsequently results in a crash rather than a near-crash. In regard to an unexpected event, which was present in approximately 78 percent of total near-crashes and 70 percent of at-fault near-crashes but just over half of the crashes (53 percent total crashes and 52 percent at-fault crashes), the absence of transient driver inattention in the majority of the near-crash SCEs (~62 percent total and ~54 percent at-fault) meant the driver was able to successfully respond to the unexpected event and avoid a crash. Thus, it appears to be the convergence of transient inattention and unexpected events that plays an important role in the increasing severity level from near-crash to crash. There were few crashes and curb strikes compared to near-crashes and crash-relevant conflicts; thus, it is premature to identify trends in the presence of specific crash trifecta elements or to rank the importance of the three elements.

Although less than one-third of all the SCEs had only one crash trifecta element present (i.e., equivalent to a single CR for an event), approximately two-thirds of all the SCEs had at least two crash trifecta elements present. In regard to at-fault SCEs, a quarter had only one crash trifecta element present, while approximately three-quarters of at-fault SCEs had at least two elements present. Additionally, similar to the results in Bocanegra et al.\(^{1}\) the current study showed that the presence of all three crash trifecta elements increased as the severity of the SCE increased. Almost one-quarter of crashes and near-crashes included all three crash trifecta elements compared to 10 percent of crash-relevant conflicts. Similarly, when focusing on at-fault SCEs, approximately one-third of crashes and over one-quarter of near-crashes were attributable to a combination of all three crash trifecta elements compared to 10 percent of crash-relevant conflicts.

The results suggest that assigning a single, unitary CR as the proximal cause of the SCE without considering additional contributing factors is likely to be a limitation that does not address the complexities involved in the genesis of a crash. Assigning a CR may be suitable for lower-severity SCEs, but when investigating higher-severity SCEs, the convergence of multiple elements needs to be recognized to adequately represent the complexities involved in the origins and formation of a crash event. Improvements to traditional crash reporting methods to account for these additional elements could include further training for police officers and/or crash investigators attending the scene of a crash. Also, the standard crash reporting form used by police could be changed to allow for additional elements to be added, rather than just reporting a
single CR. Moreover, the crash trifecta concept may be able to assist researchers in determining why a crash occurred compared with a similar situation that resulted in a successful avoidance maneuver, such as a near-crash. The crash trifecta concept may also be helpful in identifying countermeasures for crash mitigation, particularly since the two most prevalent crash trifecta elements are largely under the driver’s control (i.e., unsafe driving behavior and transient driver inattention).

LIMITATIONS

One limitation in the current study was the subjective interpretation involved in the unexpected event data reduction. Data analysts did not have access to each driver’s thoughts nor was each driver that was involved in an SCE interviewed; thus, the analysts had to judge whether the SCE involved an unexpected traffic event based on the information available to them. To mitigate this problem, the reduced data set was subjected to random reliability checks to ensure there was sufficient inter-rater reliability. Inter-rater reliability estimates were over 90 percent, indicating there was a small amount of disagreement among data analysts but, on the whole, the data reduction on the unexpected traffic event variable was reliable.

The development of in-vehicle driver-monitoring technologies may eliminate some of the need for subjective interpretation of NDS video data in the future. For example, speed- and headway-monitoring devices and lane departure systems could provide objective measures of unsafe driving behavior. Similarly, an accurate eye-tracking device would remove the need for data analysts to review and code the eye-glance data used to assess the presence of transient driver inattention. In regard to the unexpected event variable, crash avoidance technologies may assist in mitigating the impact of unexpected events while driving (e.g., by detecting roadside objects or pedestrians, or braking if the vehicle in front brakes suddenly). However, there would be instances when these technologies would not be sufficient to avoid an SCE, in which case a crash could occur.
APPENDIX A: UNSAFE DRIVING BEHAVIORS
Below is the complete list of unsafe driving behaviors from all seven NDS data sets included in the crash trifecta:

- Aggressive driving, other
- Aggressive driving, specific, directed menacing actions
- Angry
- Apparent excessive speed for conditions or location
- Cutting in, too close behind other vehicle
- Cutting in, too close in front of other vehicle
- Did not see other vehicle during lane change or merge
- Driving in other vehicle’s blind spot/zone
- Driving slowly, below speed limit
- Drowsy, sleepy, asleep, fatigued, other reduced alertness
- Exceeded safe speed, but not speed limit
- Exceeded speed limit
- Excessive braking/deceleration creating potential hazard
- Failed to signal, or improper signal
- Following too close
- Illegal passing
- Improper backing
- Improper turn: cut corner on left turn
- Improper turn: wide right turn
- Inadequate evasive action
- Inattentive or distracted
- Loss of control on dry surface
- Loss of control on slippery road surface
- Making turn from wrong lane
- Other improper or unsafe passing
- Other improper turning
- Passing on right
- Right of way error, apparent decision failure
- Right of way error, apparent recognition failure
• Signal violation
• Stop sign violation
• Sudden or improper stopping/braking
• Use of cruise control contributed to late braking
• Wrong side of the road, not overtaking
APPENDIX B: UNEXPECTED EVENT DATA REDUCTION PROTOCOL
**Loading DART:**

1. Load DART
2. Open the required collection (File → Open Collection → ThirtyFourTruck or HundredCar)
3. Login to that collection (User → Login → name/password)
4. Check that you are in the correct reduction (User → Change Reduction → CVO Distraction or Hundred Car)

![Screenshot](image.png)

Figure 5. Screenshot. Screen capture showing appropriate collection and reduction.

**Open Trigger for Analysis:**

5. Open the Query Tool (File → Query Tool)
6. Load the specific query (File → Saved Query List → crash trio_unexpected event → Load Query)
7. Click on Go
8. Open one of the triggers listed in the results

**Set Up and Analyze Trigger:**

9. Set up your viewing screen and open the video (View → Video and View → Triggers)
10. Move the blue line on the Trigger Chart to the very first point where the trigger becomes activated
11. You need to look at the 10 seconds prior to the trigger so in the Play Controller box subtract 100 from the Sync number (e.g., Sync = 1737. Subtract 100 so new Sync = 1637)

12. View the video to determine if an unexpected event occurs at some point during this 10 seconds → an unexpected event could indicate movement by an object/vehicle/animal or an unexpected event due to lack of attention.

13. An unexpected event is something random and unexpected that occurs in relation to the subject vehicle (i.e., our driver).
   i. Animal runs in front of car
   ii. Debris hits vehicle
   iii. Car pulls out in front of the vehicle
   iv. Car in front brakes suddenly
   v. Changes in traffic that happen while the subject is not paying attention (e.g., traffic moving freely, driver looks away and traffic stops)
   vi. In regards to lack of attention though, this does not include hitting stationary permanent objects that were visible the entire time (e.g., median strips, gutters, poles, etc.). Something needs to have changed in the scenario while they weren’t paying attention for it to be considered “unexpected”.

14. In the Crash Trifecta Excel file, indicate if an unexpected event was present in the appropriate column (i.e., Yes/No/Unable to determine)

15. Repeat the process from step 8 onwards for each SCE.
REFERENCES


